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BIS L-81_ Handy Programmer

1 Notes to the user

1.1 About this This manual describes startup and operation of the Handy Programmer BIS L-81_.
manual
1.2 Structure of the The manual is designed so that the sections build on one another.
manual Section 2: Basic safety information.
Section 3: The main steps for startup.
Section 4: An introduction to the material
Section 5: Technical data for the Handy Programmer.
Section 6: Steps for starting up the Handy Programmer.
Section 7: Notes on operating the Handy Programmer.
Section 8: User-defined settings for the Handy Programmer.
9

Section 9: Processing data carriers and the use of files.
Section 10: Using the Handy Programmer over the serial interface.

1.3 Conventions The following means of representation are used in this manual.
Enumerations Enumerations are represented as a list with bullet points.
- Entry 1,
- Entry 2.
Actions Instructions for actions are indicated by a preceding triangle. The result of an action is indicated
by an arrow.

» Action instruction 1.
= Action result.
» Action instruction 2.

Syntax Numbers:
— Decimal numbers are represented without additional description (e.g. 123),
— Hexadecimal numbers are indicated with the additional description nex (e.g. 00nex).

Parameters:
Parameters are represented in italics (e.g. CRC_16).

Directory paths:
Descriptions of paths in which data are stored or to be saved are represented in small caps (e.g.

ProJecT:\DATA TYPES\USER DEFINED).

Control characters:
Control characters are set in arrow brackets (e.g. <ACK>).

ASCII-Code:
Characters to be sent in ASCII code are set in apostrophes (e.g. 'L").

Cross-references Cross-references indicate where additional information on the topic can be found (see "Technical
Data" starting page 11).

Keypad entries The key sequence used to open a function or menu from the keypad of the Handy Programmer
is represented by key symbols (e.g. means: First press key 3 and then key 1).
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BIS L-81_ Handy Programmer

1 Notes to the user

1.4 Symbols A Attention!
This symbol indicates a safety instruction which must be observed.
n Note, Tip
This symbol indicates general notes.
1.5 Abbreviations BCC Block Check Character
BIS Balluff Identification System
CRC Cyclic Redundancy Code
EEPROM Electrical Erasable and Programmable ROM
EMC Electromagnetic Compatibility
PC Personal Computer
PLC Programmable Logic Controller
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2 I ——

2.1 Intended use

2.2 General safety
notes

2.3 Meaning of the
Warning notes

BALLUFF

The Handy Programmer BIS L-81_ is a component of the Identification System BIS L. Within the
identification system it is used for checking, correcting or initializing data carriers.

The Handy Programmer may be used only for this task in an industrial environment conforming
with Class A of the EMC Law.

This description applies to Handy Programmers in the product series

- BIS L-810-0-003...

- BIS L-811-0-003...

- BIS L-812-0-003...

Installation and Startup

Installation and startup may be carried out only by trained specialists. Damage caused by
unauthorized intervention or improper use is not covered under the guarantee and warranty
provisions of the manufacturer.

Follow the instructions in this guide exactly when installing and starting the system up (see
"Startup” starting page 13).

The Handy Programmer may be operated only with a power supply approved for the device (see
"Technical Data" starting page 11).

Operation and Checking

The operator is responsible for observing the locally applicable safety regulations.

In case of defects and non-clearable faults in the identification system, take it out of service and
secure against unauthorized use.

A Attention!

The pictogram associated with the word "Attention" warns of a possible hazardous
situation affecting the health of persons or resulting in equipment damage. Ignoring
these warning notes may result in injury or equipment damage.

» Always observe the described measures for avoiding the hazard.
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3 Getting Started

Interface
information

Fig. 1: Handy Programmer connections (example BIS L-811-...)

1
2
3

X1 - Read head terminal (only BIS L-811-...)
Charging socket
X2 - Serial port RS 232

X1 - 8-pin socket (only BIS L-811-...)

X2 - 5-pin terminal

7 PIN Function 4a__—_3 PIN Function
1\éc!>\\/ 6 1 A 5%\?/ 1 n.c.
p M ch 2 % y;;é\»z 2 XD

3/$ 8%\ A 3 B N 3 GND
4 +Vs 4 RxD
5 Z 5 n.c.
6 -Vs
7 TEST
8 -Vs

Prerequisites:
Supply voltage is present (battery inserted and charged).
For BIS L-811: Read/write head BIS L-3_ _ connected to X1.

Turning on the
Handy -
Programmer -

Turning on:

» Press On key.
= The display shows the start screen (device model and software version).
= At the same time a battery check is performed.
= If the battery test is successful, the main menu appears on the display.

Note
If the start screen stays on the screen after powering up, the battery voltage is too
low. Replace battery.

B www.balluff.com BALLUFF | 7



BIS L-81_ Handy Programmer

3 Getting Started

Operating menu Menu structure Key combination Function
overview Main menu
— Read Read data carrier
— Write Write to data carrier
— Edit Edit data
— File
— Load Load file
— Save Save file in EEPROM
— Data transmission Data exchange over the
serial interface
— Delete Delete files
': One entry
All entries
_— Directory Show directory
— Configuration 1
| Addresses Address ranges for reading
L Read svr:i?ing data carriers and
— Start/End address for specifying the insertion
point address for editing.
— Start/Number
Write Read +

- Start/End address
— Start/Number

Edit Write + [ENTER)
— End address
L Cursor position
| Data format Data format preset
(HEX, BCD, ASCI, BIN)
| Carrier data Data carrier information (data
carrier capacity, CRC)
'— Serial interface Parameterize interface
— Configuration 2
L L anguage Language preset
: (German, English)
Main menu 2
— Initmenu
CRC Prepare data carrier for
operation with
CRC
Read only tag Convert data carrier
(only BIS L-10_-05/L)
with CRC
without CRC
— Serial Number Read serial number

8 | BALLUFF



BIS L-81_ Handy Programmer

4 Basic knowledge

4.1 Principle of
operation of
identification
systems

4.2 Product

description

4.3 Control function

4.4 Data integrity

B www.balluff.com

The BIS L portable identification system is catagorized as a non-contacting system with read
and write function. This allows it to not only transport fixed programmed information to the data
carrier, but also to collect and send current information.

The main components of the BIS L portable identification system are:
— Handy Programmer,

— Read/write heads,

— Data carriers.

Key areas of application are:

— In manufacturing for controlling material flow (e.g. in variant-specific processes, in workpiece
transport with conveying lines, for acquiring safety-related data),

— Intool coding and monitoring,

— In process equipment organization,

— In warehousing for monitoring stock movement and levels,

— Intransport and conveying technology,

— In waste disposal for quantity-based data collection.

Handy Programmer BIS L-81_:

— Plastic enclosure,

— Reading/writing using integrated antenna (BIS L-810, BIS L-812) or by connecting a read/
write head (BIS L-811),

— System components powered by 2.4 V rechargeable NiMH battery pack,

— Editor function for editing the data to be read or written,

— Data carrier conversion possible (for BIS L-10_-05/L),

— File storage.

The Handy Programmer is the link between data carrier and host system. The Handy
Programmer can be used to check data carriers, correct them or initialize them.

The data read on the system can be stored in the Handy Programmer and later sent to the host
system.

Host systems may include:
— A host computer (e.g. industrial PC),
- APLC.

To ensure data integrity, a check procedure must be used to monitor data transfer between data
carrier and Handy Programmer.

The default setting for the Handy Programmer is double reading followed by a comparison.
Alternately a CRC_16 data check may be used.

Here a check code is written to the data carrier, which allows data to be checked for validity at
any time.

Which procedure is used depends on how the identification system is used.

Note
Mixing of both check procedures is not possible!

BALLUFF
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4 Basic knowledge

4.5 Communication
over the RS 232
interface

4.6 Files

BALLUFF

The following table provides an overview of the advantages of each check procedure.

CRC_16 data check Double read

Data security even during the non-active No user bytes are sacrificed for storing a
phase (data carrier outside the range of the check code.
read/write head).

Shorter read time - page is read only once. Shorter write time - no check code is written.

The Handy Programmer and the host system (PC/PLC) communicate over an RS 232 interface.
The data are sent using fixed telegrams.

The following possibilities exist:

— The Handy Programmer is used to process read/write jobs from the PC. The Handy
Programmer assumes the function of a BIS processor.

— The Handy Programmer manages files and exchanges stored data with the PC.

The BIS L-81_ Handy Programmer has a non-volatile EEPROM memory. This memory can be
used to store data read from a data carrier under a file name.

— The file name is limited to 8 characters.

— 15 files having a maximum size of 192 bytes per file can be stored.

File format

Start address of
the data on the
data carrier

4 bytes 4 bytes max. 184 bytes

Number of bytes  Data carrier data

Example: Data carrier file starting at address 75 with 16 bytes of data in ASCII format.
Data: ABCDEFGHIJKLMNOP

Contents of data carrier file: 00750016ABCDEFGHIJKLMNOP
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5 Technical Data

Dimensions

Fig. 2: Dimensions BIS L-810 (in mm)

Fig. 3: Dimensions BIS L-811 (in mm)

Fig. 4: Dimensions BIS L-812 (in mm)

B www.balluff.com
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5 Technical Data

Housing

Connections

Electrical data

Operating
conditions

BALLUFF

Housing material

Plastic ABS

Weight (incl. battery)

approx. 950g

Keypad 32 keys, 4 x 8 mm, alphanumeric and special
characters
Display LCD-Display, 80 characters / 4 lines

Enclosure rating

IP40 (when closed)

X2 - Serial port RS 232

RS 232 - 5-pin terminal

Internal antenna

8-pin socket (X1)

Read head BIS L-810
terminal BIS L-811
BIS L-812

Remote antenna M18

Charging socket

2.5mm jack, suitable for BIS C-701-A

Operating voltage Vs

24 V DC £10 %

Current consumption normal operation

approx. 65mA

Read/write

approx. 275mA

Voltage and current supply | Type

2.4\ rechargeable battery pack NiMH

Capacity

1650mAh

max. charging
voltage

5-10V, internally limited

Charging current

approx. 400mA

Charging time

approx. 4h

Ambient temperature range

0 °C...50°C

EMC

- EN61000-4-2/3/4/5/6
- EN55011

—  Severity level 4A/3A/AA/1A/3A
- Gr.1,CLA

Shock/vibration

EN 60068 Part 2-6/27/29/64/32
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¢} commissioning |

6.1 Interface
information

Fig. 5: Handy Programmer connections (example BIS L-811-...)

1 X1 - Read head terminal (only BIS L-811-...)
2 Charging socket
3 X2 - Serial port RS 232

X1 - 8-pin socket (only BIS L-811-...)

7 PIN Function
1 | 6 1 A
vels
2 —(@;“ t‘ﬁ 5 2 Y
2lo
PSS 3 5
3 8 4
4 +Vs
5 Z
6 -Vs
7 TEST
8 -Vs

B www.balluff.com

X2 - 5-pin terminal

a__—_3 PIN Function
Nfﬁ/ 1 n.c. 1)
Ly\’\:;\ 2 TxD
1" >—""2 3 GND

4 RxD
5 n.c. 1

1) n.c.: do not connect

BALLUFF | 13
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6 I

6.2 Battery operation  The system components of the Handy Programmer are powered by a 2.4V NiMH rechargeable
battery pack.

11—
Lﬁﬁ’ ‘J\Eﬁ’

Fig. 6: Removing the battery

1 Battery

Remove battery » Press latch.
» Slide battery down a short distance until the guide releases the battery.

Install battery » Insert battery in the guide and slide up until it latches.

Charge battery Attention!

Components can be damaged by using the wrong charging current.
» Use only chargers recommended by Balluff for charging the battery.

Battery being charged Charger
Installed BIS C-701/A
Removed BIS C-702/A

BALLUFF
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¢} commissioning |

6.4 Turning on the Prerequisites:
Handy — Supply voltage is present (battery inserted and charged).
Programmer — For BIS L-811: Read/write head BIS L-3_ _ connected to X1.
Turning on:

» Press On key.
= The display shows the start screen (device model and software version).
= At the same time a battery check is performed.
= If the battery test is successful, the main menu appears on the display.

Note
If the start screen stays on the screen after powering up, the battery voltage is too
low. Replace battery.

Possible error messages when powering up:

Message Problem
R/W head error. No BIS L-3_ _ read/write head connected.
Battery voltage too low. Battery voltage has dropped below a nominal value. The

device can only be used for a short time longer. Charge
the battery as soon as possible!

B www.balluff.com BALLUFF | 15
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(q ovcration |

7.1 Keypad and The Handy Programmer is operated from a membrane keypad with 32 keys.
display
Multiple key assignments for keypad
The letter keys and some functions keys have multiple functions.

Key type Configuration Switch
Function keys 2 different functions (sHrFT)
Letter keys 3 letters capital and small Press 1x: 1st letter

Press 2x: 2nd letter
Press 3x: 3rd letter

GHIET): Capital letters

Navigation
The LCD has 4 lines with 20 characters each. Use the keys[d] (3] to navigate between the lines
and the keys[&2]) to navigate between the characters.

The device functions are menu-driven.

7.2 Operating The main functions are shown in the main menu. Each sub-menu is indicated by a number.
concept Pressing the corresponding number key on the keypad opens the sub-menu in question.
Note

For faster orientation the key sequence for reaching a menu or a function is always
indicated in the Manual.
An overview of the menus structure can be found on page 17.

7.3 Format Data which have been read or which are to be written can be displayed in various formats.
conversions

Data » Select the display format by pressing the key (@] or (@] .

Key Display format Remark

ASCIl --> BCD --> BINARY--> ASCII | Sequential invoking of the data formats by
repeated pressing.

Hex Toggling between the currently set format and
hexademical format.

Language From the main menu you can switch between the languages German and English.

» For language selection hold down the + [E7) keys at the same time.

Note
The format conversions are only temporary until the device is turned off. The default
setting is made in the configuration menu (see "Configuration” starting page 1§).

16 | BALLUFF
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(Q ovcration |

7.4 Overview of

operating menu Mai

Mai

Menu structure

n menu
— Read

— Write

— Edit

— File

— Load

— Save

— Data transmission

— Delete

t One entry
All entries

L— Directory

— Configuration 1

— Addresses
L Read

— Start/Number
Write

— Start/Number
Edit

— End address

— Data format

— Carrier data

L— Serial interface
— Configuration 2

L Language

n menu 2

— Initmenu

CRC

Read only tag

with CRC
without CRC

B www.balluff.com

— Serial Number

[ Start/End address

— Start/End address

L— Cursor position

Key combination Function

Read +

Write +

Read data carrier
Write to data carrier
Edit data

Load file
Save file in EEPROM

Data exchange over the
serial interface

Delete files

Show directory

Address ranges for reading
and

writing data carriers and
for specifying the insertion
point address for editing.

Data format preset
(HEX, BCD, ASCII, BIN)

Data carrier information (data
carrier capacity, CRC)

Parameterize interface

Language preset
(German, English)

Prepare data carrier for
operation with
CRC

Convert data carrier
(only BIS L-10_-05/L)

Read serial number

BALLUFF
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8 Configuration

8.1 Basic knowledge

Data carrier
types

CRC Check

BALLUFF

Three types of data carriers are available for use with the BIS L-81_. Depending on your
selection either all or only one particular data carrier can be processed.

Data carrier Data
BIS L-10_-01/L | 192 bytes of user data (read/write) + 4 bytes of fixed serial number (read-
only).
BIS L-10_-05/L | 192 bytes of user data (read/write) + 4 bytes of fixed serial number (read-
only).

Or after data carrier conversion:
5 bytes of fixed serial number (read-only), corresponding to the user data.

BIS L-20_-03/L | 5 bytes of fixed serial number (read-only), corresponding to the user data.

Notes on data carriers

— Type BIS L-10_-01/L data carriers are shipped configured with FFhex37nex . Only data carriers
having this configuration are processed.

— The BIS L-10_-01/L carrier contains additional memory ranges for configuration and
protected data. These areas cannot be processed using the BIS L-81_ Handy Programmer.

— When using BIS L-10_-05/L data carriers the data distribution can be changed only once by
the Handy Programmer (data carrier conversion).

The CRC check is a procedure for determining a check value for data in order to be able to
recognize errors in data transmission. If the CRC check is activated, an error message is sent
when a CRC error is detected.

Initializing

To be able to use the CRC check, the data carriers must be initialized. There are two ways of
doing this:

— Initializing using the "Init" function in main menu 2 (see page 26).

— Initializing data carriers using the command code 'Z' (see page 35).

If the data carrier does not contain the correct CRC when reading or writing, the processor
sends the error message 'CRC-Error'.

Data carriers as shipped from the factory may be immediately written with a checksum, since all
the data are set to 0.

Error message

— If an error message is the result of a failed write attempt, then the data carrier must be
reinitialized before it can be used again.

— If an error message is not the result of a failed write attempt, then one or more of the memory
cells in the data carrier is likely defective. The data carrier must be replaced.

Checksum

The checksum is written to the data carrier as 2 bytes of information. 2 bytes per block are taken
up by this information. This leaves 14 bytes per block available. The usable number of bytes can
be looked up in the following table.

Data carrier Memory capacity Usable bytes for CRC_16
BIS L-10_-01/L 192 Byte 168 Byte
BIS L-10_-05/L 192 bytes or 168 bytes or
5 Byte 3 Byte
BIS L-20_-03/L 5 Byte CRC_16 is not supported
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8 Configuration

8.2 Configuration
menu

Configure
addresses

B www.balluff.com

If you do not wish to use the factory setting, the settings must be adjusted in the configuration

menu.

» From the main menu press the key.
= Changing to Configuration Menu 1.

The address ranges for reading and writing data carriers and for the insertion address for editing

can be preset.

Note

Applies only to BIS L-10_-01/L and BIS L-10_-05/L (not converted).

Input mode Address range
Read Write Edit
Start address (starting at byte number): 0000 0000
End address (up to byte number): 0191 0191
Start address (starting at byte number): 0000 0000
Number of bytes 0192 0192
End address: 0191
Insertion address: 0000

Input mode and address range for reading

» From the main menu press the (5] and [@J keys in
sequence.
= Changing to the submenu "Input mode: READ".

» Select input mode (Press (@] or [@J).

» Confirm entry by pressing )
= Changes to input screen "READ range".

» Enter value for the start address and confirm with

» Enter value for the end address or number of bytes to
read and confirm with .
= Changing to submenu "Input mode: WRITE".

0 -> Starts/End addr.

1 -> Starts/Number _

READ range

at byte no.:

to byte no.:

BALLUFF
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BIS L-81_ Handy Programmer

8 Configuration

Input mode and address range for reading

» Select input mode (Press [©] or (). Input mode: WRITE
» Confirm entry by pressing N
= Changes to input screen "WRITE range". 0 —> StartsEnd addr.

1 -> Start/Number _

» Enter value for the start address and confirm

with . WRITE range

» Enter value for the end address or number of bytesto = -————-----———-—————-
read and confirm with . at byts no.:
= Changes to input screen "Edit range". to byte nao.:

End address and cursor position for editing

» Enter value for the end address (highest address to be Edit range

edited) and confirm with e
» Enter value for the cursor position (= insertion address) End address:

and confirm with . Cursor position:

= Changes to Configuration Menu 1.

Select format The data format can be preset. 4 formats are available:
- HEX: Hexadecimal

- BCD: Binary Coded Decimal

- BIN: Binary

- ASCIL.

» From the main menu press the (5] and keys in
sequence.
= Changes to submenu "Data format".

—-—— Data format ---

1 HEX 3 ASCII
» Select data format using the keys [J, (@), (3] or (4] .  BCD
» Confirm entry by pressing . Current format:

= Changes to Configuration Menu 1.

Special characters in BCD format
When BCD format is selected the submenu "Special characters" appears in which the
characters Anex 10 Fhex can be converted to represent special characters.

Factory default BCD special characters:

Special characters

A o= R
B 4 g
‘cro ‘F . s

20 | BALLUFF



BIS L-81_ Handy Programmer

8 Configuration

Data carrier The settings for capacity of the data carrier and for data transmission with/without CRC are
specifications stored in the Handy Programmer.
Note

Applies only to BIS L-10_-01/L and BIS L-10_-05/L (not converted).

» From the main menu press the [5] and keys in
sequence.
= Changes to submenu "Carrier data".

» Enter data carrier capacity and confirm with . __ Carrier Data ——
» Set CRC (Y = Yes; N = No). Confirm entry by pressing Capacity:
;N T(E;hénges to Configuration Menu 1. eres
Parameterize Setting the serial interface (RS 232) for communication with an external computer.
interface (V.24)
Parameter Possible values Default
Transmission rate 9600; 19200; 38400; 57600 baud 9600 baud
Stop bits 1,2 1
Data bits 8 (cannot be changed) 8
Parity E (even); O (odd); N (none)
BCC/CR B (BCC); C(CR) B

» From the main menu press the (5] and (@] keys in
sequence.
= Changes to submenu "Serial port".

—--— Serial port ---

Baud: Data
» Enter the parameter values and confirm with . Stop: Parity:
= After confirming the parameter BCC/CR, changes to BCCACR:

Configuration menu 1.

B www.balluff.com BALLUFF | 21
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8 Configuration

8.3 Configuration The menu language and configuration are stored in Configuration menu 2.
menu 2
Set language » From the main menu press the (&), (6] and [0 keys in ~— Configuration —-
sequence.

1 Language
= Changes to submenu "Sprache - Language". 2 <

» Select language ((OJ or [2)) key.
= Changes to Configuration Menu 2.

Sprache - Langquage
1 Deutsch

2 Englisch

Save When exiting the configuration menu, you are prompted whether you want to save the
configuration configuration settings.

» "Y" to save the configuration settings and confirm with .
= Changes to Main menu.

22 | BALLUFF
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9 Function of the device

9.1 Principle of
operation
BIS L-81_

Using as a
processor

Setup with the
Handy
Programmer

B www.balluff.com

The Handy Programmer keypad is used to enter data commands (Read, Write, Edit) and
configure data exchange with the data carrier.

The location of the read/write heads for data exchange depends on the model:

Type Data exchange via
BIS L-810-... Integrated antenna, in housing
BIS L-811-... External read/write head using 8-pin socket
BIS L-812-... Integrated antenna, remote

Individual data, files or the complete file directory can be exchanged.

In addition to keypad-driven processing of the data carriers, it is also possible to carry out read
and write operations from a PC/laptop through the serial interface of the Handy Programmer.
The Handy Programmer then works like a BIS processor.

Note

Information about how the Handy Programmer works on the serial interface can be

found in Section 10 starting page 30.

Fig. 7: Setup of BIS L-810, BIS L-811 and BIS L-812

1

oONOOGRWN

Data carrier BIS L-1_ _

Plug for read/write head BIS L-3_ _

Connecting cable for read/write head BIS L-3_ _
Read/write head BIS L-3_ _

Interface cable BIS C-522-PVC-02/03

BIS L-810 Handy Programmer

BIS L-811 Handy Programmer

BIS L-812 Handy Programmer

BALLUFF
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9 Function of the device

9.2 Processing data
carriers

ead data carrier

Write to data
carrier

BALLUFF

Note
Applies only to BIS L-10_-01/L and BIS L-10_-05/L (not converted).

READ data carrier

» From the main menu press the key.
= Changes to the submenu "Read data carrier".

at byte no.:

to byte no.:

Note
The appearance of the menu depends on the input
mode (see "Configure addresses" starting page 19).

Displayed default values:
— The values preset in the configuration when the device is first powered up,
— The last entered values as long as the device has not been turned off.

» Confirm default values in sequence with . READ data carrier

o | .

» Changing default values. For editing use the keys
and (@] to switch between the input fields. Apply
changes by pressing .
= Read operation is started (flashing black bar).

ﬂ Note

The data carrier must remain within the read zone
while being read.

For possible error messages see "Error messages" on
page 29.

at byte no.:

to byte no.:

After successful reading the data are displayed in the preset
data format (for setting the data format see "Operation" on
page 16).

ﬂ Note

For multi-page displays navigate using the and
keys.

Display 0000 - 0015

Balluff GmbH

» Press :

= Changes to Main menu.

Write data carrier

» From the main menu press the [2] key.
= Changes to the submenu "Write data carrier".

at byte no.:

to byte no.:

Note
The appearance of the menu depends on the input
mode (see "Configure addresses" starting page 19).

Displayed default values:
— The values preset in the configuration when the device is first powered up,
— The last entered values as long as the device has not been turned off.
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Edit data

Initialize data
carrier
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» Confirm default values in sequence with .

or:

» Changing default values. For editing use the keys
and to switch between the input fields. Apply

changes by pressing .
= Write operation is started (flashing black bar).

Note

The data carrier must remain within the read zone
while being written to.

For possible error messages see "Error messages" on
page 29.

After successful writing the display reverts to the main menu.

» From the main menu press the key.
= Changes to the menu for specifying the insertion
address (cursor position).
» Enter the address starting at which you want to edit.
Confirm entry by pressing .
= Changes to Edit menu.

» Edit insertion address ( value range 0000-0191).

The data are shown in the preset data format see
"Operation" on page 16).

Navigation for editing:

- [B&): Go to the next character (HEX: next half-byte).

- : Go to the previous character (HEX_ previous half-byte).
- [@: One line higher.

- [BJ: One line lower.

Exit editing: Press .
= Changes to Main menu.

v

WRITE data carrier

at byte no.:

to byte no.:

edit cursor position

at byte no.

Edit Byte No.

The data carrier is programmed with OOnex and thereby prepared for operation with CRC.

From the main menu press the [(&] key.
= Changes to Main menu.2
» From the main menu 2 press the key.
= Changes to the Init menu.
» From the Init menu press the [@J key.
= Changes to the menu "Write data carrier".
» Press .
= The data carrier is programmed with OOhex .
= Changes to the Init menu.

v

———— Initmenu —-—--
1 CRC
2 read only tag

6 <——

BALLUFF
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Convert data Type BIS L-10_-05/L data carriers can be converted so that their properties match those of the
carrier BIS L-20_-... data carrier type.
Attention!
The data carrier can only be converted once. The data carrier conversion cannot be
reversed.

Type BIS L-10_-05/L data carriers can be initialized for data transmission with or without
checksum. Depending on the selection, transmission of the serial number can be done in one of
the following two ways:

- BIS L-10_-05/L with CRC: 3 bytes,

— BIS L-10_-05/L without CRC: 5 bytes.

» From the main menu press the key.
= Changes to Main menu.

» From the main menu 2 press the key.
= Changes to the Init menu.

———— Initmenu —-—--
1 CRC

2 read only tag

» From the Init menu press the [2] key. &
= Changes to the menu "read only tag".
» From the "read only tag" menu select the option with or ___ read only tag ——-
without CRC (@] or (2] key). L with CRC
= Changes to the submenu "read only tag" for entering 5 without CRC
the serial number. ¢

» In the submenu "read only tag" enter the 3 bytes (with
CRC) or 5 bytes (without CRC) of the serial number.

» Press ' —-—— read only tag —---
= The Handy Programmer sends the data for data

carrier conversion (flashing black bar on the display).
» Bring type BIS L-10_-05/L into the active zone of the
read/write head.
= The data carrier is converted.
= The serial number of the converted data carrier is
displayed.

00 00 00 00 00 hex

Del <——

» Press .
= Changes to the Init menu.

Note
An already converted data carrier cannot be converted again. In this case the Handy
Programmer sends an error message (see "Error messages" on page 29.)

26 | BALLUFF



BIS L-81_ Handy Programmer

9 Function of the device

Read serial
number

9.3 Working with files

Open file menu

Load file

Save file

B www.balluff.com

Reading out the serial number:

BIS L-10_-01/L: 4 bytes
BIS L-10_-05/L converted, with CRC: 3 bytes
BIS L-10_-05/L converted, without CRC: 5 bytes
BIS L-20_-03/L: 5 bytes

From the main menu press the key.
= Changes to Main menu. READ Serial Number
From the main menu 2 press the keyy. 0 e
= Changes to the menu "READ Serial number".
Press .
= The serial number is read and then displayed in HEX
format.
Press .
= Changes to Main menu.

The BIS L-81_ Handy Programmer has a non-volatile EEPROM memory. This memory can be
used to store data read from a data carrier under a file name.

» From the Main menu press the [[4] key.

= Changes to File menu.

Loading a file stored in EEPROM memory to the working memory of the Handy Programmer.

From the File menu press the key.

Enter the name of the file to be loaded and press the --- File menu —--

key, 1 Load 4 Delete

= The start address and end address or number of 2 Save 5 Directory
bytes of the loaded file are displayed. 3 Trans. 6 End

Press .

= Changes to File menu.

Storing data located in the working memory of the Handy Programmer to a file in the EEPROM.

» From the File menu press the key.
» Enter the name of the file to be saved and press the Please enter name:

[ETE ke,

= Changes to File menu.

BALLUFF
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Data exchange Exchanging data between Handy Programmer and laptop/PC over the serial interface.

Note
For details on data exchange over the serial interface see "Working over the serial
interface" starting page 30.

Delete files » From the File menu press the key.
» Inthe Deletion menu select the type of deletion. --- Deletion menu ---
1l = One entry
Deleting an entry. 2 = All entries
» Enter file name and confirm with . 6 <——

= The file is deleted.

Deleting all entries.
= All entries are immediately deleted (no prompt).
= Changes to File menu.

Show directory Display the files stored in the EEPROM.
» From the File menu press the (5] key.
= The list of stored files is displayed.
» Press .
= Changes to File menu.
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9.4 Error messages
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Possible error messages on the device display and their meanings are listed in the following

table.

Error message

Possible cause

Remedy

Read error
Function cancelled

Data carrier removed too
soon from the read/write
zone.

Acknowledge error message

by pressing [ENTER] .

= Changes to Main menu.

exceeded

the configured capacity of the
data carrier.

Write error Distance between data carrier | » Reduce distance.
Function cancelled and read/write head too » Read data carrier again.

great.

Data carrier cannot be read or

Read data carrier written. » Reduce distance.
?7?7?Distance??? » Check configuration.

Distance between data carrier |» Replace data carrier.
Write data carrier and read/write head too » Read data carrier again.
??7?Distance??? great.

End address or start address

+ number of bytes lies

outside the data carrier

capacity.

Data carrier defective.
Maximum end address End address is greater than  |» Acknowledge error message

by pressing[ENTER] .

= Changes to Main menu.

Read error Data carrier configurationin | » Change configuration.
Wrong carrier the Handy Programmer does |» Exchange data carrier.

not agree with that of the
Write error data carrier.
Wrong carrier
Read error Read/write operation failed » Acknowledge error message
Distance/others the 3rd time. by pressing[ENTER] .

= Changes to Main menu.

Write error » Restart read/write operation.
Distance/others

BALLUFF
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10.1 Connecting the
Handy
Programmer to a
PC/Laptop

Data
transmission

10.2 Protocol
sequence

Read

BALLUFF

The serial port can be used to connect the Handy Programmer to a PC/laptop and be operated

like a BIS processor.

The following functions can be carried out over the serial interface:

— Read and write operations from a PC or laptop

— Sending files between the Handy Programmer and PC/laptop.

Preparation
» Use the BIS C-522 cable to connect the Handy Programmer to the PC/laptop see

"Accessories" on page 45).
» To work with files, install the BISHandy.exe program on the PC/laptop.

Note
You can find the BISHandy.exe program on the supplied BIS-CD.

» From the main menu press the key.
= Changes to File menu.
» From the File menu press the key.

= Data transmission is activated.

To end data transmission and return to the File menu:

Press (€] .

Data transmission

The Handy Programmer and PC/laptop communicate with each other using a fixed protocol.

1. No error occurs:

PC/Laptop —

Command

BIS L -81

t t2

<STX>

<ACK>'0" |

Data

— Base setting

3

t3 = max. 50 ms

t2 2 0 (is not monitored by the Handy Programmer)

t1 Depends on the number of bytes to be read (see "Read times" on page 39)

2. An error occurs:

PC/Laptop —

Command

BISL -81

t

<NAK> + Error-No. |— Base setting

t1 Depends on the number of bytes to be read (see "Read times" on page 39) and error type (recommended monitoring time 15 s)
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Write
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1. No error occurs:

PC/Laptop — Command

BIS L -81

<STX> Data

<ACK> "0’

t2

<ACK>'0" [— Base setting

t1 = max. 50 ms

t2 2 0 (is not monitored by the Handy Programmer)

t1 Depends on the number of bytes to be written (see "Write times" on page 39)

2. There is an error in the command:

PC/Laptop — Command

BIS L -81

<NAK> + Error-No.

— Base setting

t1 = max. 50 ms

3. There is a write error:

PC/Laptop — Command

BIS L -81

<STX> Data

t

<ACK> '0'

t2

<NAK> + Error-No.

— Base setting

t1 = max. 50 ms

t2 2 0 (is not monitored by the Handy Programmer)

t1 Depends on the number of bytes to be written (see "Write times" on page 39) and error type (recommended monitoring time 30 s)

n Prerequisites for validity of the displays:

— The Handy Programmer is in the base setting.
— There is a data carrier in front of the read/write head.

BALLUFF
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10.3 Communication

Telegram types
with associated
command (ASCII
characters)

Explanation of
telegram
contents

Telegram
terminator

32 | BALLUFF

The host system an

associated with the

d Handy Programmer communicate with each other via telegrams. There are
specific telegrams for the individual operations. These always start with the command which is

telegram type.

‘L' Read the data carrier

'P’ Write to the data carrier

'C' Write a constant value to the data carrier

Q' Restart the Handy Programmer - Quit

'Z' Initialize data carrier for CRC_16 data check

T Send file to the Handy Programmer

'G' Load file from the Handy Programmer

'D' Load file directory from the Handy Programmer
'E' Delete a particular file in the Handy Programmer
'K’ Delete all files in the Handy Programmer

n Note

Continuous querying of the interface is not allowed. The wait time between two

command
With teleg

s must be at least 300 ms.
ram types 'T', 'G', ‘D', 'E' and 'K" only BCC is used for data integrity (not

depending on the configuration setting).

Start address
and number of
bytes

ﬂ Note

The start address (A3, A2, A1, AO) and the number of bytes to be sent (L3,
L2, L1, LO) are transmitted as ASCII characters. The range between 0000
and 191 can be used for the start address and 0001 to 192 for the number
of bytes. A3 ... LO stand for one ASCII character each.

The sum of the start address and the number of bytes may not exceed the
usable data carrier capacity.

The acknowledgement <ACK> '0" is sent by the identification system when
the serially transmitted characters were recognized as correct and there is a
data carrier within the active zone of a read/write head.

<NAK> + 'Error-No." is acknowledged if an error was recognized or if there

is no data carrier within the active zone of a read/write head.

Start

<STX> starts data transmission.

Sent bytes

The data are sent code-transparent (no data conversion).

The factory default setting is Blockcheck BCC.
The commands for reading and writing can also be terminated with Carriage Return 'CR'
depending on the configuration. The file commands must always be terminated with Blockcheck

BCC.

Command Terminator
ILI‘ IPI’ ICI, IQI, IZI BCC Or ICRI
T, 'G', 'D", 'E', 'K' | always BCC

The Handy Program
type.

mer likewise terminates all sent telegrams using the selection Terminator
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Read/Write Data
Carrier telegram
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Reading from the data carrier, writing to the data carrier.

Task |Data |Com- |Start address |Number of Termi- |Acknowl- |Start of Data 3) Termi- |Acknowl-
flow [mand |of the first bytes to be nator  |edgement 2)sending nator  [edgement 2)
byte to be sent
sent
ToHP|'L' A3A2A1A0 L3L2L1LO BCC <STX>
4) ‘- 000 0001 "1'0o0r
BIS BIS CR
§ 0191 0192
T From <ACK> "0 D1 D2 D3...Dn BCC or
HP 5) or 'CR'
<NAK> +
Error No.
1)
ToHP |'P! A3A2A1A0 L3L2L1LO BCC <STX> D1 D2 D3...Dn BCC or
4) ‘0000 0001 "1'%0or 'CR'
BIS BIS CR
2 0191 0192
2 Fom <ACK> "0’ <ACK> "0’
HP 5) or or
<NAK> + <NAK> +
Error No. Error No.
1) 1)
1) The Quit command is not permitted at this point.
2) The acknowledgement is '0" if no error was detected, or <NAK> + 'Error No.', if an error
occurred.
3) Data from start address to start address + number of bytes.
4)  From host system to Handy Programmer.
5) From Handy Programmer to host system.
Note
Examples of telegrams can be found in Section 10.6 starting page 40.
BALLUFF
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Telegram: Writea  Write a constant value to the data carrier.
constant value to  This command can be used to delete a data carrier. The time for sending the bytes to be written

the data carrier is saved.
Task [Data |Com- |Start address |[Number of Termi- |Acknowl-  |Start of Data 3) Termi-  |Acknowl-
flow [mand |of the first bytes to be nator  |edgement 2) sending nator  |edgement 2)
byte to be sent
sent
ToHP ['C' A3A2 A1 A0 L3L2L1LO BCC or <STX> d BCC or
4) ‘- 000 '0O0O0 1T '"1'0CR 'CR’
BIS BIS
i) ‘0191 0192
2 Fom <ACK> "0’ <ACK> "0’
HP 5) or or
<NAK> + <NAK> +
Error No. Error No.
1) 1)

1) The Quit command is not permitted at this point.

2) The acknowledgement is <ACK> '0" if no error was detected, or <NAK> + "Error No.', if an error
occurred.

3) Data from start address to start address + number of bytes.

4)  From host system to Handy Programmer.

5)  From Handy Programmer to host system.

Telegram: Restart  Sending the Restart command (Quit) cancels any telegram currently in progress. The Handy
the Processor Programmer goes into its base state.
(Quit)

A Attention!
The Restart command (Quit) is not permitted while the Handy Programmer is waiting
for a Terminator character (BCC or 'CR).
In this situation Quit is misinterpreted as a terminator or information character.

n Note

After acknowledging this telegram allow a pause of at least 1600 ms before starting
a new telegram.

Task Data flow Command |Terminator Acknowl-  [Terminator 2)
edgement 2),
Restart (Quit) From host system to Handy Q BCC or 'CR'
Programmer
From Handy Programmer to host Q' BCC or 'CR'
system

1) The Quit command is not permitted at this point.

Note
Examples of telegrams can be found in Section 10.6 starting page 40.
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Telegram:
Initialize
CRC_16 data
checking
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This telegram initializes a data carrier located in front of the active read/write head for using
CRC_16 data checking.
The telegram must then be resent if a CRC error results from a failed write operation.

Attention!
The sum of the start address and number of bytes may not exceed the usable data
carrier capacity (see "CRC Check" on page 18).

Task Data |Com- [Start address |Number of Termi- |Acknowl- Start of |Data 3) Termi- |Acknowl-
flow [mand |of the first bytes to be nator  |edgement 2) |sending nator  |edgement 2)
byte to be sent
sent
Initialize  To HP |'Z' A3A2A1A0 L3L2L1LO BCC or <STX> D1 D2 D3...Dn BCC or
CRC_16 4) ‘0 000 00O 1 "1'0'CR 'CR'
range BIS BIS
‘0191 0192
From <ACK>'0' <ACK> '0'
HP 5) or or
<NAK> + <NAK> +
Error No. Error No.
1) 1)
1) The Quit command is not permitted at this point.
2) The acknowledgement is <ACK> '0" if no error was detected, or <NAK> + "Error No.', if an error
occurred.
3) Data from start address to start address + number of bytes.
4)  From host system to Handy Programmer.
5) From Handy Programmer to host system.
BALLUFF
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Telegram:
Import file

Telegram:
Read out file
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Send file from PC/laptop to the Handy Programmer.

Task [Data |Com- |File name 3) |Start address |Number of Termi- |Acknowl- |Start of |Data 4) Termi- |Acknowl-
flow [mand onthe data [bytesonthe |nator [edgement 2)/sending nator |edgement 2)
carrier data carrier
Read To HP |'T' ‘D7 ... DO' ABA2A1A0 L3L2L1LO BCC <STX> D1 D2 D3...Dn BCC
file in 5) 'SAMPLE_ ' '0 0 0 0" '0 0 O 1'
BIS BIS
0191 0192
From <ACK>'0' <ACK> '0'
HP 6) or or
<NAK> + <NAK> +
Error No. Error No.
1) 1)
1) The Quit command is not permitted at this point.
2) The acknowledgement is <ACK> '0" if no error was detected, or <NAK> + "Error No.', if an error
occurred.
3) If the file name is less than 8 characters in length, spaces (20hex) must be added.
4) Data from start address to start address + number of bytes.
5) From host system to Handy Programmer.
6) From Handy Programmer to host system.
Read out file from Handy Programmer to PC/laptop.
Task Data [Com- |File name 3) |Termi- Start of |Start address |Number of Data 4) Terminator
flow |mand nator sending |on the data  [bytes on the
carrier data carrier
Read out fle ToHP ['G'  'D7 ... DO' BCC <STX>
5) 'SAMPLE_ _'
From <ACK>'0' A3SA2A1A0 L3L2L1LO D1D2D3..Dn BCC
HP 6) or ‘0000 '00O0 1
<NAK> + BIS BIS
Error No. ‘191 0192
1) 1)

1) The Quit command is not permitted at this point.

2) The acknowledgement is <ACK> '0" if no error was detected, or <NAK> + 'Error No.', if an error

occurred.

o0 s L

If the file name is less than 8 characters in length, spaces (20hex) must be added.
Data from start address to start address-number of bytes.
From host system to Handy Programmer.
From Handy Programmer to host system.

Note

Examples of telegrams can be found in Section 10.6 starting page 40.
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Telegram: Read Read out file directory Handy Programmer to PC/laptop.
out file directory

Task Data flow Command | Terminator| Acknowledgement 2) [Start of sending Data Terminator
Read out file From host system to ‘D! BCC <STX>
directory Handy Programmer
From Handy <ACK> '0' or D1 D2 D3...Dn BCC
Programmer to host <NAK> + Error No.
system
1) 1)

1) The Quit command is not permitted at this point.
2) The acknowledgement is <ACK> '0" if no error was detected, or <NAK> + "Error No.', if an error

occurred.
Telegram: Delete a particular file in the Handy Programmer
Delete file
Task Data flow Command|File name 3) Terminator| Acknowledgement 2)
Delete a particular file From host system to Handy Programmer 'E' 'D7 ... DO' BCC
'SAMPLE_ _'
From Handy Programmer to host system <ACK> '0' or
<NAK> + Error No.
1)
1) The Quit command is not permitted at this point.
2) The acknowledgement is <ACK> '0" if no error was detected, or <NAK> + "Error No.', if an error
occurred.
3) If the file name is less than 8 characters in length, spaces (20hex) must be added.
Telegram: Delete all files stored in the Handy Programmer.
Delete all files
Task Data flow Command|Termir1ato Acknowledgement 2)
Delete all files From host system to Handy Programmer 'K BCC
From Handy Programmer to host system <ACK> '0" or <NAK> + Error No.
[ v

1) The Quit command is not permitted at this point
2) The acknowledgement is <ACK> '0" if no error was detected, or <NAK> + "Error No.', if an error
occurred .

Note
Examples of telegrams can be found in Section 10.6 starting page 40.
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10.4 Error numbers BIS L-81_ always outputs an error number. Their meaning is given in the following table.

38
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No. Error Effect 1)
0 No error. Only in conjunction with <ACK>.
1 No data carrier present. Handy Programmer goes into the base state.
2 Read error. Handy Programmer goes into the base state.
3 Read cancelled because Handy Programmer goes into the base state.
the data carrier was
removed.
4 Write error. Handy Programmer goes
into the base state.
- .
5 Write cancelled because Handy Programmer goes Attentlpn. When a write
) . operation is cancelled,
the data carrier was into the base state. )
removed incomplete data may have
' been written to the data
carrier. 2)
6 Interface error. Handy Programmer goes into the base state
(Parity or stop bit error).
7 Telegram format error. Handy Programmer goes into the base state.
Possible format errors:
- Commandis not 'L', 'P', 'C", 'Q' or 'Z'.
— Start address or number of bytes lies outside the
permissible range.
8 BCC error. The BCC sent for read/write operations is wrong.
Handy Programmer goes into the base state.
e CRC error. Handy Programmer goes into the base state.
The CRC on the data
carrier is wrong. 3
i EEPROM error. Processor goes into the base state.
q Timeout. Character delay time of 1 s exceeded. Interface problem.
r Entry error. Specified file does not exist.
S
: Memory error. Handy Programmer memory end reached.
V Interface error. Improper setting for interface parameters (baud rate,
parity, data or stop bit error).
W | Protocol format error. Protocol format not observed.
X BCC error. The BCC sent for file operations is incorrect.
Telegram cancelled.
Handy Programmer goes into the base state.

1)
2)
3)

An error always results in cancelling of the telegram.
If using CRC data check, the error message E may occur at the next read command if error 4 or 5 was not remedied.

If using CRC data check, the error message E may occur if error 4 or 5 was reported for the preceding command.
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10.5 Read/write times
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Note

The indicated times are valid beginning when the data carrier is recognized. Otherwise
you must add 45 ms for power to be built up until the data carrier is recognized.

Read times in static mode (data integrity with double read, no CRC_16 data check):

Data carrier BIS L-1_ _ with 4-byte blocks

Data carrier BIS L-2_ _

bytes started

Data carrier recognition ~ 370 ms
Read bytes 0 to 3 ~ 180 ms
for each additional 4 +~90ms

Data carrier
recognition

+

Read data carrier.

~270ms

Write times in static mode (data integrity with double read, no CRC_16 data check):

Data carrier BIS L-1_ _ with 4-byte blocks

Data carrier BIS L-2_ _

Data carrier recognition ~ 370 ms Writing not possible.
Write bytes O to 3 ~ 305 ms

for each additional 4 +~215ms

bytes started

Read times in dynamic mode (data integrity with double read, no CRC_16 data check):

Data carrier BIS L-1_ _ with 4-byte blocks

Data carrier BIS L-2_ _

Data carrier recognition ~ 370 ms Data carrier ~270ms
Write bytes O to 3 ~ 180 ms rfcogr"t'o”
for each additional 4 +~90ms Read data carrier.
bytes started
BALLUFF

39



40

BIS L-81_ Handy Programmer

1 0 Working over the serial interface

10.6 Telegram
examples

Forming the BCC
block check

Protocol variants
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The BCC is formed out as an EXOR operation on the serially transmitted binary characters of the

telegram block.

Example: Read starting at address 13, read 128 bytes.

The command line without BCC is: 'L 0013 0128 10'. BCC is formed:

'L

- 00O N 242 O W <+ O O

Q

Resulting block check: ~ BCC

EXOR
EXOR
EXOR
EXOR
EXOR
EXOR
EXOR
EXOR
EXOR
EXOR
EXOR
=D’

= 0100
= 0011
= 0011
= 0011
= 0011
= 0011
= 0011
= 0011
= 0011
= 0011
= 0011
= 0100

1100
0000
0000
0001
0011
0000
0001
0010
1000
0001
0000
0100

If necessary the terminator using BCC can be replaced with Carriage Return ('CR").

In the preceding example the command line 'L 0013 0128 10 D' contains 'D' as BCC. This
command line is compared here with the possible variations. The various forms of
acknowledgement with and without terminator are shown.

Command line from host
system to BIS

Acknowledgement from
BIS for correct reception

Acknowledgement from
BIS for incorrect reception

With BCC as terminator,

'L 00130128 10 D! <ACK> 'O <NAK> '1"
With 'CR' instead of BCC
'L 0013 0128 10 CR! <ACK> "0 <NAK> '1"

In the table the error example is <NAK> '1' (= no data carrier present).
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Read from the Telegram example: Read from data carrier with BCC.
data carrier
Operation: Read 10 bytes from the data carrier starting at address 50.

The host system sends: ‘L 0050 0010 1 O I' BCC (49ne)

Address of the first byte to read — L

Number of bytes to read

Fixed in protocol

Fixed in protocol

The Handy Programmer acknowledges with: <ACK> "0

The host system gives the start command: <STX>

The Handy Programmer provides

the data from the data carrier: '"123456789A" F' BCC (70nex)
L

Write to the data Telegram example: Write to the data carrier with BCC.
carrier (1)
Operation: Write 5 bytes to the data carrier starting at address 50.

The host system sends: ' 0050 0005 1 0 Q' BCC (51nex)
Address of the first byte to write S I

Number of bytes to be written

Fixed in protocol

Fixed in protocol

The processor acknowledges with: <ACK> 'O

The host system gives the start command and the

data: <STX> 12345 3 BCC (33nex)
The processor acknowledges with: <ACK> 'O L
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1 O Working over the serial interface

Write to the data Telegram example: Write a constant value to the data carrier with BCC.

carrier (2)
Operation: Write 50 bytes to the data carrier starting at address 20 with the ASCII data value
0 (SOhex).
The host system sends: '‘C 0020 0050 1 0O E' BCC (46ne)
Address of the first byte to write — L |
Number of bytes to be written
Fixed in protocol
Fixed in protocol
The processor acknowledges with: <ACK> 'O’
The host system gives the start command and the
data: <STX> '0 2" BCC (32nex)
The processor acknowledges with: <ACK> '0' I
Restart the Telegram example: Restart the processor (Quit) with BCC.
Handy
Programmer Operation: Place the BIS system in the base state.
(Quit)
The host system sends: '‘Q Q' BCC (51hex)
L |
The Handy Programmer acknowledges with: '‘Q Q' BCC (51hex)
L
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1 0 Working over the serial interface

Read file in Telegram example: Send file to the Handy Programmer with BCC.

Operation: Send the file MUSTER1 to the Handy Programmer. Write 5 bytes to the data carrier
starting at address 27.

The host system sends: T MUSTER1u 0027 0005 M' BCC (4Dnex)
File namer) 4, |—,

Address of the first byte on the data
carrier

Number of bytes to be written

The Handy Programmer acknowledges with: <ACK> '0'
The host system gives the start command and the data: <STX> '12345 3' BCC (32nex)
The Handy Programmer acknowledges with: <ACK> '0' |_|

Read out file Telegram example: Read file from the Handy Programmer with BCC.

Operation: Read the file MUSTER1 from the Handy Programmer. Read 5 bytes from the data
carrier starting at address 27.

The host system sends: 'G MUSTER1u A' BCC (5Ehex)
File namer) 4’ I—,

The Handy Programmer acknowledges with: <ACK> "0

The host system sends: <STX>

The Handy Programmer sends: ‘002700512345 1' BCC (31hex)

L]

Read out file Telegram example: Read file directory from the Handy Programmer with blockcheck BCC.

directory
Operation: Read the file directory from the Handy Programmer. 2 files are stored in the Handy
Programmer.
The host system sends: ‘D D' BCC (44nex)

L

The Handy Programmer acknowledges with: <ACK> '0'
The host system sends: <STX>

The Handy Programmer sends: '0002MUSTER1000270005MUSTER2000350012 <EOT>'

BCC (O4hex)
1)

Always fill file name with 8 bytes. Even a space character (20hex) used for filling must be accounted for in the BCC.
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1 0 Working over the serial interface

Delete a file Telegram example: Delete file in Handy Programmer with blockcheck BCC.

Operation: Delete the file MUSTER1 from the directory in the Handy Programmer.

The host system sends: 'E MUSTER1u \' BCC (5Chex)

S N N

File name+)

The Handy Programmer acknowledges with: <ACK> '0'

Delete all files Telegram example: Delete all files in the Handy Programmer with blockcheck BCC.

Operation: Delete all files from the Handy Programmer.

The host system sends: 'K K' BCC (4Bhex)
The Handy Programmer acknowledges with: <ACK> "0

1) Always fill file name with 8 bytes. Even a space character (20hex) used for filing must be accounted for in the BCC.
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Appendix

Ordering code

Accessories
(scope of
delivery)

Accessories
(optional, not
included in scope
of delivery)

B www.balluff.com

Balluff Identification System
Series L Read/Write System

Hardware Type

810 =

811

812

Interface

Internal antenna.

With keypad and display, for connecting to a PC or laptop

with 9-pin SUB-D plug (serial)

8-pin integral socket for connecting standard BIS L-3_ _ read/

write heads via cable.

With keypad and display, for connecting to a PC or laptop

with 9-pin SUB-D plug (serial)
Remote antenna.

With keypad and display, for connecting to a PC or laptop

with 9-pin SUB-D plug (serial)

0 = RS 232 (V.24 interface)

Software type
003 = Balluff Software for BIS L-81_-...

Type

Carrying Pouch

Type
Charger

Charging stand

Additional battery

Connection cable:
for 9-pin SUB_D COM port

Connection cable:
One molded male connector, other end
pigtailed, length can be trimmed as

needed

Connector:
without cable

Read heads BIS L-3_ _

2.4V rechargeable NiMH;

for BIS L-811-...;

for BIS L-811-...

for BIS L-811-...

Ordering Code

149525

Ordering Code
BIS C-701-A

BIS C-702/A
125997

BIS C-522-PVC-02
BIS C-522-PVC-03

BKS-S115-PU-02

BKS-S117-00

see catalog
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Appendix

Accessory
Charger
BIS C-701-A

Technical Data

Accessory
Charging Stand
BIS C-702-A

Technical Data

46 | BALLUFF

Features

— Consists of charger/AC adapter with 2.5mm plug,
— primary plug EURO, UK, US interchangeable (included),

— Approvals: CE, UL.

Primary voltage Uprimary 100 - 240Vac
Secondary voltage Usec 6Voc + 5%
Input frequency Frrimary 47 - 63Hz
Secondary current lsec 21A

Ambient temperature Ta -40°C ... +70°C

Material PPE-V1-125°C
Color black
Housing MPP10

Output cable

Ordering code

11.7892.503-80

Length, diameter

2000mm, 3 x 0.5mm?2

Connector

2.5mm plug

Features

— Consists of charger/AC adapter with charge state indicator and base,

— primary plug EURO, UK, US interchangeable (included),

— Approvals: CE, UL.

Charge state indicator

LED red - battery charged

LED red flashing - battery charging

Primary voltage Uprimary 100 - 240Vac
Secondary voltage Usec 6 Voc + 5%
Input frequency Frrimary 50 - 60Hz
Secondary current lsec 800mA

Ambient temperature Ta -40°C ... +70°C

Material PPE-V1-125°C
Color black

Housing MPP10

Qutput cable Ordering code 11.7892.503-80

Length, diameter

2000mm, 3 x 0.5mm?2
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Appendix

ASCII Table
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Decimal Hex Control ASCII Decimal Hex ASCII Decimal Hex ASCII
Code
0 00 Ctrl @ NUL 43 2B + 86 56 Vv
1 01 Ctrl A SOH 44 2C , 87 57 W
2 02 Ctrl B STX 45 2D - 88 58 X
3 03 Ctrl C ETX 46 2E 89 59 Y
4 04 Ctrl D EOT 47 2F / 90 5A z
S 05 Ctrl E ENQ 48 30 0 91 5B [
6 06 Ctrl F ACK 49 31 1 92 5C \
7 07 Ctrl G BEL 50 32 2 93 5D [
8 08 Ctrl H BS 51 33 3 94 5E A
9 09 Ctrl | HT 52 34 4 95 5F _
10 0A Ctrl J LF 53 35 5 96 60
11 0B Ctrl K VT 54 36 6 97 61 A
12 0C Ctrl L FF 55 37 7 98 62 B
13 oD Ctl M CR 56 38 8 99 63 ©
14 OE CtrIN SO 57 39 9 100 64 d
15 OF Ctrl O Sl 58 3A 101 65 e
16 10 Ctrl P DLE 59 3B ; 102 66 f
17 11 Ctrl Q DCA 60 3C < 103 67 g
18 12 Ctrl R DC2 61 3D = 104 68 h
19 13 Ctrl S DC3 62 3E > 105 69 i
20 14 CtlT DC4 63 3F ? 106 6 A j
21 15 CtrlU NAK 64 40 @ 107 6B k
22 16 Ctrl v SYN 65 41 A 108 6C L
23 17 Ctrl W ETB 66 42 B 109 6D m
24 18 Ctrl X CAN 67 43 c 110 6E n
25 19 Ctrl'Y EM 68 44 d 111 6F o
26 1A Ctrlz SUB 69 45 e 112 70 p
27 1B Ctrl [ ESC 70 46 f 113 71 q
28 1C Ctrl\ FS 71 47 g 114 72 r
29 1D Ctrl ] GS 72 48 h 115 73 S
30 1E Ctrl A RS 73 49 i 116 74 t
3il 1F Ctrl _ us 74 4 A j 117 75 u
32 20 SP 75 4B k 118 76 \
B 21 ! 76 4C L 119 77 W
34 22 " 77 4D m 120 78 X
35 23 # 78 4E n 121 79 Y
36 24 $ 79 4F o} 122 7A z
37 25 % 80 50 p 123 7B {
38 26 & 81 51 q 124 7C |
39 27 ‘ 82 52 r 125 7D }
40 28 ( 83 53 s 126 7E ~
41 29 ) 84 54 t 127 77 DEL
42 2A * 85 55 u
BALLUFF
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A

Abbreviations 5
Accessories 45
Address range

Read 19

Write 20
Areas of application 9
ASCII Table 47

B

Battery

install 14

Load 14

remove 14
Blockcheck BCC 32

C

Charger 46
Charging stand 46
Check procedure 9
Checksum 18
Connecting 30
Connections 12, 13
Control function 9
Conventions 4

Convertible data carriers 26

CRC Check 18
Cursorposition
Edit 20

D

Data
Edit 25
Data carrier
Configuration 21
Converting 26
Initializing 18, 25
Processing 24
Read 24
Types 18, 23
Write 24
Data format 20
Capacity 21
Data integrity 9
Data transmission 30
Dimensions 11
Display format 16

E

Electrical data 12
End address

Edit 20

Read 19

Write 20
Error message 18
Error messages

Display 29
Error numbers 38
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F

File menu
Opening 27

Files 10, 27
Delete 28
File format 10
File name 10

H

Handy Programmer
Product description 9
Housing 12

Input mode 19
Read 19
Write 20
Insertion address
Edit 20
Intended Use 6
Interface
parameterizing 21
Interface information 13

K

Key assignments 16
Keypad
Navigation 16

L
Language selection 16
M

Main components 9
Meaning
Warning notes 6

o

Operating conditions 12
Ordering code 45

P

Principle of operation 23
Product description 9
Protocol sequence

Read 30

Write 31

R

Read times 39
RS 232 interface 10, 13

S

Safety
Commissioning 6
Installation 6
Operation 6

Save configuration 22

Serial interface
parameterizing 21

Serial number
Read 27

Set language 22

Setup 23

Special characters 20

Start address
Read 19
Write 20

Symbols
Representation 5

T

Telegram
Data checking 35
File directory 37
Files 36
Read data carrier 33
Restart 34

Write to data carrier 34

Telegram examples 40
Telegram terminator 32
Telegram types 32
Turn on the unit 15

W
Write times 39
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